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Before you begin

Introduction

Welcome to the Getting Started guide for Microsofte Virtual PC for
Mac Version 7. Each section in this guide describes a specific
step in the installation process and corresponds to the same step
on the Installation Overview pullout guide. Use both resources
together to track your progress as you install Virtual PC 7 and
Microsoft Windowsa for the first time.

4 Introduction
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This table describes the information included in each section of

the guide.

m this section

Learn how to )

Before you begin

Identify the components of
Virtual PC 7 and prepare to
install Virtual PC 7.

Step 1 Install Virtual PC 7

Installl Virtual PC 7.

Step2 Create a
virtual machine

Create a virtual machine, install
and configure an operating
system, import a virtual machine
to Virtual PC 7, and transfer docu-
ments from a virtual machine to a
new virtual machine in Virtual PC 7.

Step 3 Set up your
virtual machine

Start and shut down your virtual
machine, configure settings for
your virtual machine, and establish
printer and network connections
for your virtual machine.

Step 4 Install Windows-
based programs

Install and start Windows-based
programs.

More help and support

&

Get more information about regis-
tration and product support for
Virtual PC 7 and Windows. Y,

About Virtual PC 7

Virtual PC 7 is a sophisticated software program that allows you
to create one or more virtual machines, each running its own
operating system, on a single Macintosh computer. The virtual
machine emulates a standard x86-based computer, including all
of the basic hardware components. By using emulated hardware,

About Virtual PC 7)(5
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each virtual machine works like a separate physical computer.
Because each virtual machine has its own operating system, you
can run several different operating systems at the same time on
a single Macintosh computer.

The following diagram illustrates the relationship of the
Virtual PC 7 application to the operating systems.

Windows +
Windows-based programs

Virtual PC 7 + virtual machine

] 1
\é’ Mac OS X + Macintosh computer

A}

Virtual machine components

In Virtual PC 7, you can create multiple virtual machines,
configure settings for each virtual machine that you create, and
manage access to external hardware devices, such as printers
and USB devices. The Virtual PC 7 application is the control

6 About Virtual PC 7



Before you begin

center for creating and managing your virtual machines. Each
virtual machine that you create has the following components.

A virtual machine configuration document Each virtual
machine that you create is represented on your Macintosh by a
virtual machine configuration document. A virtual machine
configuration document is a file that contains all of the
configuration information for a virtual machine, including the
virtual machine settings and the virtual hard disk image.

Virtual hard disk image A virtual hard disk image is the hard
disk of the virtual machine. Because a virtual machine does not
have physical components, it cannot store information on a
physical hard disk. Instead, a virtual machine stores information
in a virtual hard disk image. By default, the virtual hard disk
image is a dynamically expanding file that grows in size as you
install applications or store data in it.

An operating system installed on the virtual hard disk image

A supported operating system must be installed on the virtual
hard disk image. If the version of the Windows operating system
that you want to install is not included with Virtual PC 7, you must
acquire and install an operating system that is supported.

Important The supported operating systems are

» Windows XP Professional, Windows XP Home
Edition, and Windows 2000 Professional. Refer to
the Read Me for details. The Read Me is included on
the Virtual PC 7 Installation CD and in Virtual PC 7
on the Help menu.

Emulated hardware The virtual machine emulates a standard
x86-based computer, including all of the basic hardware
components.

About Virtual PC 7 7
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What’s new in Virtual PC 7

Virtual PC 7 features many improvements in performance and
ease of use.

Improved performance Virtual PC 7 is optimized for Mac OS X
and features improved graphics and visual display. Programs
launch quickly, refresh easily, and are more responsive.

G5 support Run Windows-based programs on Apple’s fastest
new hardware.

Easy installation Get started quickly with streamlined
installation of Virtual PC 7 and a Microsoft Windows
operating system.

Easy printing Use the same printer as your Macintosh if you are
running Mac OS X version 10.3.x (Panther). No special printer
configuration is required.

Fast Save Shut down and save the state of your virtual machine
in one easy step. When you use the Fast Save feature, all
Windows-based programs that are running on your virtual
machine when you shut down will be running when you restart
your virtual machine.

Help Find new resources and step-by-step instructions in this
Getting Started guide and Virtual PC 7 Help.

Expanded preferences and settings Customize your virtual
machine by using new application preferences and virtual
machine settings.

8 About Virtual PC 7
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Visual tour of Virtual PC 7

To use Virtual PC 7 and your virtual machine, you must interact
with three separate user interfaces:

o Mac OS X
@ \irtual PC7
o Windows

These user interfaces are shown in the following illustration and
described in the tour of Virtual PC 7 that follows.

Virtual PC 7 application

@ vinwal PC_File Edit \es Window _Help B 4 Fril12:41 FMIidm\n
o mes |
Shut Down. s [f .
000 Pause *0 = ¢

1 1ype cut-Al-petete
Reset

.
PC Settings. s [IOID S i)

nstall
Tran

Windows Mac OS X
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Mac OS X

The visual elements of Mac OS X are the Macintosh desktop,
menu bar, and the Dock.

Macintosh desktop Unless you are running Virtual PC 7 in full-
screen mode, the Macintosh desktop is always visible on your
monitor. When a virtual machine is running, it is visible in the
virtual machine window on the Macintosh desktop. You can
switch between the virtual machine window and Mac OS X, as
you would any application for the Macintosh. Simply minimize the
virtual machine window to view the entire Macintosh desktop.

Menu bar The menu bar at the top of the Macintosh desktop
changes according to the application that is active. When

Mac OS Xis active, the Finder menu displays to the right of the
Apple icon. When Virtual PC 7 is active, the Virtual PC menu
displays to the right of the Apple icon. To change the active menu
bar, click either the Macintosh desktop or the virtual machine
window. If Virtual PC 7 is running but the virtual machine window
is not visible, you can activate the Virtual PC 7 menu bar by
clicking the Virtual PC 7 icon in the Dock.

Dock The Macintosh Dock can be used with Virtual PC 7 to
provide quick access to your virtual machine. You can set the
following to display in the Dock: Virtual PC 7, the Start menu for
the Windows operating system, and Windows-based programs
running on each virtual machine.

10 Visual tour of Virtual PC 7
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Virtual PC 7

Use the Virtual PC 7 application to create and manage virtual
machines and to configure settings for each virtual machine. The
visual elements of the Virtual PC 7 application are the menu bar,
Virtual PC List, and the virtual machine window.

Menu bar The menu bar at the top of the Macintosh desktop
changes according to the application that is active. When

Mac OS X is active, the Finder menu displays to the right of the
Apple icon. When Virtual PC 7 is active, the Virtual PC menu
displays to the right of the Apple icon. To change the active menu
bar, click either the Macintosh desktop or the virtual machine
window. If Virtual PC 7 is running but the virtual machine window
is not visible, you can activate the Virtual PC 7 menu bar by
clicking the Virtual PC 7 icon in the Dock.

The following table describes each menu in Virtual PC 7.

(Use thismenu | To )

Virtual PC Quit Virtual PC 7, get your product identifi-
cation number (PID), register Virtual PC 7, or
set application preferences for your virtual
machines.

File Create a new virtual machine, import a virtual
machine to Virtual PC 7, transfer documents
from a virtual machine created with a

previous version of Virtual PC to a new virtual
machine in Virtual PC 7, open a virtual

machine window, or close a virtual machine

\_ window and save its state (Fast Save). )

Visual tour of Virtual PC 7 1
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rUse this menu

To )

Edit

Work with text and capture screens. Use
the Type submenu to type Windows-based
keyboard combinations (such as CTRL+ALT+
DELETE Of PRINT SCREEN) with your

Macintosh keyboard.

PC

Start up, shut down, or restart (reset) your
virtual machine; transfer documents from a
virtual machine created with a previous
version of Virtual PC; install or update Virtual
Machine Additions; or configure settings for
each virtual machine, such as printer and
network connections and full-screen display.

Drives

Capture, release, and eject CDs, DVDs,
and floppy disks or CD, DVD, and floppy
disk images.

Window

Start Virtual Disk Assistant, start Virtual PC
List, or manage multiple virtual machine
windows.

Help

-

Access Virtual PC 7 Help, visit the Virtual PC 7
product Web site, or check for product
updates. )

Virtual PC List Virtual PC List displays all of the virtual machines
you have created and the current status of each. If you have
multiple virtual machines, use Virtual PC List to start, shut down,
and change settings for each virtual machine. To start Virtual PC
List, in Virtual PC 7, on the Window menu, click Virtual PC List.

1ZXVisucl tour of Virtual PC 7



ou begin

Virtual machine window The virtual machine window on the
Macintosh desktop displays your virtual machine. The title bar of
the virtual machine window displays the name of the virtual
machine that is currently running.

The virtual machine window also includes the Virtual PC 7
toolbar, which is located in the bottom left corner of the virtual
machine window. The toolbar provides shortcuts to important
virtual machine settings and application preferences; the colored
lights indicate activity for the function.

The following table describes each icon on the Virtual PC 7
toolbar.

(Use this icon To )

E Virtual hard | Modify or view the settings for your
disk image | virtual hard disk image, or create a new
virtual hard disk image by using Virtual
Disk Assistant.

@ CD/DVD Capture or release a CD, DVD, CD
image, or DVD image.
|:1 Shared Create a shared folder or modify the
folders settings of a shared folder.

"'ﬁ" usB Install a USB device and assign it to
either your virtual machine or your
Macintosh.

B Printer Select the Virtual Machine Additions

Printer. This is only available if you are
running Mac OS X version 10.3.x on
\_ your Macintosh. Y,

Visual tour of Virtual PC 7X13
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(Use this icon

To )

CPU
indicator

View the total CPU usage for the

Virtual PC 7 application and modify how
Virtual PC 7 performs and responds when
Virtual PC is running in the background
and other applications are running in

the foreground.

Virtual PC 7 shares processor resources
with each application running on your
Macintosh. The load meter indicates the
portion of the Macintosh processor that
is currently being used by the Virtual PC 7
application. Because the load meter indi-
cates the processor usage of the

Virtual PC 7 application rather than the
individual virtual machine, the load meter
displays the same measurement in each
virtual machine when multiple virtual
machines are running simultaneously.

The load meter functions properly
only if Virtual Machine Additions and a
supported Windows operating system
are installed.

Floppy
disk

Capture or release a floppy disk or floppy
disk image. If your Macintosh computer
does not have a floppy disk drive, you
can capture a floppy disk image by
dragging it to this icon. By default, this
icon does not appear in the toolbar.

i
\

Network

View or modify the network connection
for your virtual machine. By default, this
icon does not appear in the toolbar. )

14XVisu0l tour of Virtual PC 7
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The floppy disk and network icons do not appear in the

Virtual PC 7 toolbar unless you add them to the toolbar. You

can add or remove icons by selecting the Toolbar application
preference. To do this, on the Virtual PC menu, click Preferences.

Windows

The visual elements of the Windows operating system are the
Windows desktop and the Start menu.

Windows desktop The Windows desktop includes its own
taskbar and program-specific menu bars. Each Windows-based
program that is running on your virtual machine appears in the
Windows taskbar.

Start menu The Start button in the lower left corner of the
desktop opens the Start menu from which you can start
Windows-based programs, change settings for the Windows
operating system, access files that you have saved, or get help
with using Windows.

Visual tour of Virtual PC 7 15



Before you begin

The following table describes the main elements of the Start
menu in Windows XP. The elements for Windows 2000 are in

parentheses ().

(Use To )
Control Panel Change the way the Windows oper-
(Settings) ating system looks and behaves;

add and remove Windows-based
programs; install and troubleshoot
hardware; or set the date, time, and
time zone for your computer.
Control Panel in the Windows operat-
ing system is similar to Preferences in
Mac OS X.
All Programs Start Windows-based programs.
(Programs)

My Documents
(Documents)

Save and open your documents
directly from this folder.

My Recent Documents

Open documents that have been
recently used.

Search Search for files, folders, printers, and
computers on your network; or
search for files, folders, and printers
on your virtual machine.
Help and Support Access Windows Help and links to
(Help) updates and support for Windows on
\_ the Microsoft Web site. Y,

16KVisu0l tour of Virtual PC 7
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Before you install Virtual PC 7

This section describes the requirements for installing Virtual PC 7
and creating or importing a virtual machine.

Tip Use the Installation Overview to help you
@ with the setup process. This pullout guide provides
an overview of the setup process from installing

Virtual PC 7 to installing a Windows-based program
on your new virtual machine.

What you need before you install Virtual PC 7
Have these items available before you begin the setup process.

System requirements
To install and run Virtual PC 7 on your Macintosh computer, you
must have the following:

e 700 MHz or faster native G3, G4, or G5 processor; the
processor speed must be a part of the physical computer and
cannot be added as a CPU accelerator

® Mac OS X version 10.2.8 (Jaguar) or 10.3.x (Panther);
Mac OS X version 10.3.x is required for the Macintosh G5

CD-ROM drive
Minimum of 512 MB RAM
3 GB or more of free hard-disk space

1024 x 768 or higher-resolution monitor that displays
thousands of colors

= Mouse or compatible pointing device

Before you install Virtual PC 7 17
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Supported operating systems

The operating systems supported for use with Virtual PC 7 are
Windows XP Professional, Windows XP Home Edition, and
Windows 2000. Refer to the Read Me content for specific details
about the supported operating systems. The Read Me content is
included on the Virtual PC 7 Installation CD, and in Virtual PC 7
on the Help menu.

Product keys

The Virtual PC 7 setup process requires you to enter separate
product keys for Virtual PC 7 and the Windows operating system.
The product key for Virtual PC 7 is located on the back of the
Virtual PC 7 media case.

The product key for Windows is a 25-digit number with the format
XXOXXXXXXX-XXXXXXXXXX-XXXXX. This number is typically included
with the product packaging. If your copy of Virtual PC 7 includes a
Windows operating system, the product key for Windows is
located on the back of the Virtual PC 7 media case.

18 Before you install Virtual PC 7
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Before you import a virtual machine

Before you import a virtual machine to Virtual PC 7, make sure
that the virtual machine has been shut down completely in the
version of Virtual PC that was used to create it. Data from a
virtual machine with a “Saved” status cannot be migrated to
Virtual PC 7. To shut down a virtual machine completely, you must
use the Shut Down command (Shut down option). For more
information about importing a virtual machine, see “Migrate data
from an earlier version of Virtual PC,” p. 42.

Installing the upgrade version of Virtual PC 7

If you purchased an upgrade version of Virtual PC 7, you need
to have Virtual PC for Mac version 5.x or 6.x installed on your
Macintosh. It is not possible to upgrade to Virtual PC 7 from
versions of Virtual PC earlier than version 5.0.

Before you install Virtual PC 7 19
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Step 1 Install Virtual PC 7
Begin installing Virtual PC 7

This section provides instruction for installing Microsofte
Virtual PC for Mac Version 7.

Important To install Virtual PC 7, you must log on to

» your Macintosh as an administrator. If you are
installing Virtual PC 7 on Mac OS X version 10.2.8,
the order of the screens may vary.

Insert the Virtual PC 7 Installation CD into the CD drive on your
Macintosh. The following installation screen appears.

8006 ‘4 Virtual PC for Mac version 7 o
B2 3 items, 573.6 MB available

AN e )
N .ns[ﬁm

‘Doubl-clck this icon ta nstol
for Mac version 7

=
=05
Read Me

Doubl-slck this ison for tha lotsst
Infarmaten about Virusl PC.

[
Manuals & Tools

This foldar contoine odditional
urinatcila.

Virtlial PC for Mac

If the screen does not automatically appear, double-click the
Virtual PC 7 CD icon that appears on the Macintosh desktop.

The installation screen has three options:

Install Virtual PC This opens the Virtual PC Installer.

Read Me This opens a document that contains important
information regarding Virtual PC 7.

ZOXBegin installing Virtual PC 7
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Manuals & Tools This folder contains an electronic copy of
this Getting Started guide, the installation guide for the version
of the Microsoft Windowse operating system included on your
Virtual PC 7 Installation CD (if applicable), and a tool for
removing Virtual PC 7.

You can review the Read Me or the contents of the Manuals &
Tools folder now or later. To open the Virtual PC 7 Installer,
double-click Install Virtual PC. The Welcome to the Virtual PC
Installer screen appears.

Overview of the setup process

The Installer guides you through each step of the installation. The
diagram on the Welcome to the Virtual PC Installer screen
provides an overview of the entire Virtual PC 7 setup process
from installing Virtual PC 7 to configuring Windows.

Review the Read Me content

Open the Read Me and read it before installing Virtual PC 7. The
Read Me provides important information regarding Virtual PC 7.
You can print or save the Read Me content.

Accept the End-User License Agreement

The End-User License Agreement (EULA) defines the terms of use
for Virtual PC 7. You can print or save the EULA. To accept the
terms of the EULA, click Continue, and then click Agree. If you
click Disagree, the installation is cancelled.

Select a volume or disk on which to install Virtual PC 7
You must install Virtual PC 7 on the Mac OS X startup volume
or disk.

To select the volume or disk on which you want to install
Virtual PC 7, click the icon for the volume or disk. The green arrow

Begin installing Virtual PC 7)(21
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points to the volume or disk on which Mac OS X is installed. You
must install Virtual PC 7 on this same volume or disk.

Select the type of installation

The Easy Install installation type is the standard for all
installations of Virtual PC 7. The Customize button provides a
customized view of the features to be installed. All options listed
are installed.

Your Macintosh computer restarts after Virtual PC 7 is installed.
If you do not want to restart your computer, you can cancel the
installation process at this time. When you are ready to install
Virtual PC 7, insert the Virtual PC 7 Installation CD and repeat the
installation process from the beginning.

Authorize the installation of Virtual PC 7
The Installer verifies that the administrator for this Macintosh
computer authorizes installing Virtual PC 7.

If you do not know the user name and password or passphrase
that were used to install Mac OS X, look for an Administrator
account in Accounts in System Preferences. Use that name and
the associated password or passphrase. To get help with your
administrator name and password or passphrase, click @

Install software

To install Virtual PC 7 now, click Continue Installation. After
Virtual PC 7 is successfully installed, click Restart. Your
Macintosh restarts and the next phase of the Virtual PC 7
setup process begins.

22><Begin installing Virtual PC 7
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|660 Install Virtual PC

Install Software

O Introduction

© Read Me
© License
~ Oselect Destination
&=0 llation Type The software was successfully installed

Click Restart to finish installing the software.

Important To install the Windows operating system
» included with Virtual PC 7, do not remove the

Virtual PC 7 Installation CD from the CD drive of
your Macintosh until you either finish configuring
the Windows operating system or are prompted to

remove the CD.

Log on with your Macintosh administrator password
or passphrase

After you restart your Macintosh, log on with your Macintosh
administrator password or passphrase before you continue
installing Virtual PC 7. If you do not do this, you may be asked
to enter the product key for Virtual PC 7 each time you start
Virtual PC 7.

Use the Virtual PC for Mac Setup Assistant

After you log in as an administrator, the Virtual PC for Mac Setup
Assistant starts. If the Virtual PC for Mac Setup Assistant does
not start immediately after you log on as an administrator,
double-click the Applications folder, and then double-click
Virtual PC.

Begin installing Virtual PC 7)(23
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(®00 Virtual PC for Mac Setup Assistant

Welcome

Welcome to Section 2 of the Microsoft Virtual PC for Mac
version 7 installation.

Setting Up Setting Up
Windows

In Section 2 you will personalize your Virtual PC for Mac application
and install Windows from your Virtual PC for Mac version 7 CD. This
vill take anywhere from 15 minutes to 1 hour.

Should you need further assistance, please consult the Getting
Started Guide or Virtual PC's built-in Help which is accessible
through the Help menu.

Enter user information

Enter your name and the product key for your copy of Virtual PC 7.
If you cannot find the product key, look for a sticker on the back of
your Virtual PC 7 media case.

(@00 Virtual PC for Mac Setup Assistant

User Information

To unlock this copy of Virtual PC for Mac, enter your name,
arganizatian (optional), and the Virtual PC for Mac product key.

Name: I |

Organization:

Virtual PC for Mac Product Key:

Type your Virtual PC for Mac product key in the boxes above. Do not
worry about entering hyphens or capitalizing letters—this will be
done automatically.

For assistance locating your Product Key, clck the Help button. (2)

To proceed, enter your name and product key.

(Caminae)

A product identification number (PID) is assigned to you. You
need this number if you contact Microsoft Product Support
Services for technical support. The PID does not appear on any
labels so you may want to write it down at this time. You can also

24XBegin installing Virtual PC 7
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find this number in Virtual PC 7 by doing the following: On the
Virtual PC menu, click About Virtual PC, and then click Info.

What's next?

After you receive your PID, you are finished installing and setting
up Virtual PC 7. The next step depends on whether your copy of
Virtual PC 7 includes a Windows operating system.

If your copy of Virtual PC 7 does not include Windows,
proceed to “If Virtual PC 7 does not include Windows;
p. 27. If your copy of Virtual PC 7 includes Windows,
proceed to “If Virtual PC 7 includes Windows; below.

If Virtual PC 7 includes Windows

If the version of Virtual PC 7 that you have just installed includes
a Windows operating system, you do not need to create an initial
virtual machine. This version of Virtual PC 7 includes a pre-
configured virtual machine on which the Windows operating
system has been installed but only partially configured. You must
first install the virtual machine on your Macintosh and then finish
configuring the Windows operating system.

Install your virtual machine

By default, the configuration document (which contains the
configuration information and operating system files for your
virtual machine) is installed in the User/Documents/Virtual PC
List folder on your Macintosh hard disk.

To install the configuration document in the default location, click
Continue. To install it in another location, click Change Location,
select the location you want, and then click Continue.

What's next?XZS
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(800 Virtual PC for Mac Setup Assistant

Install Windows

O user Information

Space avallable: 7.7 GB

Change Location...

Configure Windows

You are now ready to finish the Virtual PC for Mac Setup Assistant
and then finish configuring the Windows operating system that is
installed on your virtual machine.

Before finishing the Virtual PC for Mac Setup Assistant, you may
want to review the information about configuring the Windows
operating system. When you finish the Virtual PC for Mac Setup
Assistant, you can find this information in this guide and in
Virtual PC 7 Help.

To finish the Virtual PC for Mac Setup Assistant and finish
configuring Windows, click Start Windows.

[ Proceed to “Configure the Windows operating system? )
p. 35.
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If Virtual PC 7 does not include Windows

If you just installed a version of Virtual PC 7 that does not include
a Windows operating system, click Finish to finish the Virtual PC
for Mac Setup Assistant.

You are now ready to do one of the following:

e Use the Create New PC Assistant to create a
virtual machine.

( Proceed to “Create a virtual machine; p. 28. )

= |mport a virtual machine or transfer documents that were
created in a Windows-based program from a virtual
machine to Virtual PC 7. This process applies only if you
created a virtual machine in a version of Virtual PC earlier
than Virtual PC 7.

Virtual PC} p. 42.

Tip Itis not necessary to create or import a virtual
@ machine at this time. However, before you can use
Virtual PC 7, you must either create an initial virtual

machine in Virtual PC 7 or import a virtual machine
from an earlier version of Virtual PC.

( Proceed to “Migrate data from an earlier version of )

What's next?XZ?
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Step 2 Create a virtual machine

Create a virtual machine

To use Microsofte Virtual PC for Mac Version 7, you must create or
import a virtual machine to use with Virtual PC 7. Use the Create
New PC Assistant to create a virtual machine if:

= You have just installed a version of Virtual PC 7 that does
not include a Windowss operating system and you need to
create an initial virtual machine in Virtual PC 7.

= You want to create additional virtual machines in
Virtual PC 7.

If the version of Virtual PC 7 that you have just installed includes
a Windows operating system, you do not need to create an initial
virtual machine. This version of Virtual PC 7 includes a pre-
configured virtual machine on which the Windows operating
system has been installed but only partially configured. To finish
configuring the Windows operating system, proceed to “Configure
the Windows operating system,” p. 35.

For more information about importing a virtual machine from a
previous version of Virtual PC to Virtual PC 7, see “Migrate data
from an earlier version of Virtual PC,” p. 42.

Install an operating system not included with
Virtual PC 7

Use the Create New PC Assistant to create an empty virtual
machine and then install an operating system of your choice.

Depending on a variety of factors, including the speed of your
Macintosh and the operating system you are installing, it may
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take some time to install your own operating system. Times can
range from 30 minutes to over 2 hours.

To create an empty virtual machine
1 Ifyou have not already done so, in Virtual PC 7, on the File
menu, click New.

2 Click Install your own operating system, and then
click Begin.

3 Click Continue.

4 Inthe Operating System list, click the operating system you
want to install on your virtual machine. If the operating
system you want to install is not listed, select Unspecified.

5 Based on the operating system you selected, the possible
formats for the virtual hard disk image are displayed. Under
Hard Disk Format, do one of the following:

@ To select the default format for the virtual hard disk
image, click Continue.

The default format is the recommended format for your
operating system.

e To select a different format, click a format, and then
click Continue.

Some file formats are not compatible with certain
operating systems. Incompatible formats for the
selected operating system are dimmed and cannot be
selected.

6 Inthe Name box, type the name for your virtual machine.

You can either accept the name that is provided, or you can
create your own name. For best results, use the name of
the operating system that you are installing, for example,
Windows XP Professional.
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7 Toinstall the configuration document (which contains the
configuration information and operating system files for
your virtual machine), do one of the following:

e To accept the default location, click Create.

By default, the configuration information and operating
system files for your virtual machine are installed in the
User/Documents/Virtual PC List folder on your
Macintosh hard disk.

= To select a different location, click Change Location,
select a location, and then click Create.

To continue, follow the steps to install an operating system.

To install an operating system
1 Onthe Install Your Operating System screen, click Start PC.

A black screen displays the following message “OS not
found. Install an OS on this hard drive.”

2 With Virtual PC in the foreground, insert the CD that
contains the operating system into the CD drive of your
Macintosh.

The CD is now captured for use by Virtual PC 7. If the CD is

not automatically captured, in Virtual PC 7, on the Drives
menu, click Capture Disc.
If you have an operating system that requires installing
from a floppy disk, you need either a floppy disk drive on
your Macintosh computer or a floppy disk image that
contains the installation information. For more information
about using floppy disk images, see Virtual PC 7 Help.

3 InVirtual PC 7, on the PC menu, click Reset.

4 To confirm that you want to restart the virtual machine,
click Reset again.
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5 When the text “Press any key to boot from CD.” appears on
the screen, immediately press any key on your keyboard.

Tip You must press a key on your keyboard quickly,
without pausing. Otherwise, the black screen with the

message “OS not found. Install an OS on this hard
drive” appears again, and you will need to click Reset
on the PC menu in Virtual PC 7.

If you are installing an unsupported operating system, refer to the
instructions that came with your software.

If you are installing Windows, wait while the Windows setup
program installs the necessary files. This process may take
some time.

After the files are installed, the Welcome to Setup screen
appears for Windows. Use your keyboard instead of your mouse
device to complete each task in the Windows installation

that follows.

To continue the installation of Windows
1 When you see the Welcome to Setup screen, press RETURN.
To cancel the installation, press F3.

2 Toaccept the terms of the End-User License Agreement
(EULA), press F8. To cancel the installation, press Esc.

3 Select a partition for the virtual hard disk image and then
press RETURN.
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Accept the partition that is selected by default, which you
selected when you created the virtual hard disk image,
unless you are certain you want to do otherwise. Your
screen should look something like the following:

2@ 0 <« O son )

4 Press RETURN.

The file system that is selected by default reflects the
partition option you selected in the Create New PC
Assistant. Use the file system that is selected by default
unless you are sure that you need to select a different file
system. To select a different file system, use the arrow
keys on your keyboard to select the file system, and then
press RETURN.

Caution Do not convert your file system to the
NTFS file system unless you are certain that you
want to use the NTFS file system. You cannot convert

back to a FAT file system once you have an NTFS file
system. FAT32 provides the best compatibility with
Virtual PC 7.
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The following illustration shows the list of available file systems.

Windows XP Professional

on partition

15359 MB ¢ 15355 MB free)

ENTER=Continue ESC-Cancel

2@ 0 < o sl

v

The Windows operating system files continue copying to your
virtual hard disk image. There may be numerous progress
screens, and this process may take some time.

When the installation is complete, proceed to
“Configure the Windows operating system; p. 35.

Install a version of Windows included with
Virtual PC 7

Use the Create New PC Assistant to install the virtual machine
and Windows operating system included with Virtual PC 7. Do not
use this option to install any other operating system. To install a
different operating system, follow the instructions in “Install an
operating system not included with Virtual PC 7, p. 28.
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To install a version of Windows included with
Virtual PC 7

1

6

If you have not already done so, in Virtual PC 7, on the File
menu, click New.

On the Select a Setup Method screen, click Install from a
Virtual PC for Mac CD, and then click Begin.

If you have not already done so, insert the Virtual PC 7
Installation CD into your CD drive, and then click Continue.

In the Name box, type the name for your virtual machine,
such as Windows XP Professional.

You can either accept the name that is provided, or you
can create your own name. The default is the name of
the operating system you are installing, for example,
Windows XP Professional.

To install the configuration information and operating
system files for your virtual machine, do one of the
following:
= To accept the default location, click Install.
By default, the configuration information and operating
system files for your virtual machine are installed in the
User/Documents/Virtual PC List folder on your
Macintosh hard disk.

= To select a different location, click Change Location,
select a location, and then click Install.

On the Getting Started screen, click Start Windows.

Important To install the version of Windows that is
included with Virtual PC for Mac version 5.x or 6.x,

you must create a new virtual machine in the earlier
version of Virtual PC, install the Windows operating
system, and then import the virtual machine to
Virtual PC 7. The Windows operating system that
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you install must be supported in Virtual PC 7.
The operating systems supported for use with
Virtual PC 7 are Windows XP Professional,
Windows XP Home Edition, and Windows 2000.
Refer to the Read Me content for specific details
about the supported operating systems. The
Read Me content is included on the Virtual PC 7
Installation CD, and in Virtual PC 7 on the

Help menu.

For more information about importing a virtual machine, see
“Migrate data from an earlier version of Virtual PC,” p. 42.

Configure the Windows operating system

Whether you installed your own operating system or the Windows
operating system included on the Virtual PC 7 Installation CD,
you need to configure or finish configuring the Windows operating
system. The Windows setup assistant walks you through the
configuration process. This section provides pointers to
information you will need for some steps in the setup process. It
does not cover every setup screen.

Procedures and sample configuration screens in this section are
for an installation of Windows XP Professional. The process is
similar for configuring Windows XP Home Edition and

Windows 2000.

Product key information for Windows

You already provided the product key for Virtual PC 7. Because

the Windows operating system is a separate Microsoft product,
you need to provide the product key for the Windows operating
system, as well.
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The product key for Windows is a 25-digit number with the format
XHXXXX-XXXXX-XXXXXXXXXXXXXXX. This number is typically included
with the product packaging. If your copy of Virtual PC 7 includes a
Windows operating system, the product key for Windows is
located on the back of the Virtual PC 7 media case.

Computer hame

The Windows setup assistant suggests a computer name.

This computer name is different from the name you use with
Mac OS X or the name of your virtual machine, which appears on
the virtual machine title bar and in Virtual PC List. This name is
used only to identify your virtual machine on a business or home
network and on the Internet.

If you are on a business network, check with the network
administrator to determine your computer name. If you are on a
home network in which printers or other devices are shared
among multiple computers, select a unique name to distinguish
your virtual machine from other computers or devices on your
home network.

Even if you are not on a network, you should enter a computer
name because some Internet service providers (ISPs) require
that you use a specific computer name to identify your computer
and to validate your Internet account.

If you are asked to enter a description for your computer, enter a
description that will help you identify it on a network.

Administrator password

Most versions of the Windows operating system require an
administrator password. As the administrator for this virtual
machine, you need to assign it a password, which will control
access to this virtual machine. While it is possible for others to
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use this virtual machine and the Macintosh computer, there are
certain tasks that can be performed only by the administrator.
To limit the number of passwords you must remember, you can
use the same administrator password that you use for your
Macintosh computer.

Network settings

The setup assistant may look for network settings, and you may
need to select a type of network configuration. The types of
network configurations are:

Typical These network settings have been preconfigured
to perform the majority of tasks in the Windows operating
system. This option is the recommended setting and is
selected by default.

Important For best results, select the Typical
option. If you use custom network settings, you may
compromise the performance of Virtual PC 7.

Custom This option is for advanced users who want to
customize their network settings. If you change the network
settings, always use Dynamic Host Configuration Protocol
(DHCP) unless you are using a domain or your network
administrator tells you to use a setting other than DHCP.
DHCP is a Transmission Control Protocol/Internet Protocol
(TCP/IP) that allows a network connected to the Internet to
automatically assign a temporary IP address to a host when
the host connects to the network. For more information
about custom network settings, check with your network
administrator.
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Workgroups

In some versions of Windows, you may need to indicate if your
virtual machine is a member of a domain or a workgroup. Use the
following descriptions to decide if your virtual machine needs to
be a member of either a domain or a workgroup:

Workgroup A workgroup is made up of one or more
computers with the same workgroup name. Workgroups share
information, such as files and folders, and hardware resources
such as printers. You do not need special permissions to join a
workgroup. You can join a workgroup by entering the
workgroup name. You can use the workgroup name that is
provided, or you can create your own. If you are notin a
workgroup, leave the default setting in the workgroup or
domain box.

Domain A domain is a collection of computers on a network
that share common information, and is managed by a network
administrator. To join a domain, you must have a user account
that allows you to add a computer account to the domain.

Important Ifyou are unsure or are not part ofa
» business network, do not select Domain. Use the

default setting. You can join your virtual machine to

a domain later, after you finish installing Windows.
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Connecting to the Internet

By default in Virtual PC 7, virtual machines connect to the
Internet and networks by using Shared Networking. Shared
Networking uses the Internet and network connections that have
been set up for your Macintosh.

Important Shared Networking requires Windows to
a be configured to connect through a network, even
when your Macintosh may connect to the Internet
and networks though a dial-up modem, DSL, cable,
or other Macintosh connection. If you configure
Windows to connect to the Internet directly, you may

compromise the performance of Virtual PC 7.
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The following table shows which options to select for use with

Shared Networking.

(When the options are

Select this option

Digital subscriber (DSL)
line or cable modem

Local area network (LAN)

Local area network (LAN)

Local area network or
home network

Directly to the Internet

Local area network or home
network

Use a username and
password to connect

Always connected to
the Internet

-

Always connected to the Internet

If the User Name and Password
to Connect to the Internet screen
appears, your Macintosh may not
be connected to the Internet. In
Virtual PC 7, your virtual machine
uses the network settings of the
Macintosh to connect to the
Internet. After you configure
Windows, establish a connection
to the Internet for your Macintosh.
For more information about
Internet connections on the
Macintosh, see Mac OS X Help.

J

After you configure Windows, you can optionally connect your
virtual machine to the Internet independently of your Macintosh,
by setting your virtual machine to use Virtual Switch networking.
Additionally, you may need to make changes to the network
settings in the Windows operating system. For more information
about Virtual Switch networking, see Virtual PC 7 Help.

4OXConﬁgure the Windows operating system



Step 2 Create a virtual machine

High-speed Internet connection

If you are prompted to select high-speed connection settings,
such as an Internet Protocol (IP) address, always select the
Obtain IP automatically and Obtain DNS automatically
check boxes.

Important If you change the network settings,

» always use Dynamic Host Configuration Protocol
(DHCP) unless you are using a domain or your
network administrator tells you to use a setting
other than DHCP. DHCP is a Transmission Control
Protocol/Internet Protocol (TCP/IP) that allows a
network connected to the Internet to assign a
temporary IP address to a host automatically when
the host connects to the network. Do not use a
static IP address with Virtual PC 7 unless you are
using Virtual Switch networking on a network that
requires static addresses. Consult your network
administrator for more information.
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Windows desktop

The configuration process is complete when you see the Windows
desktop in the virtual machine window, as shown in the following
illustration. In Windows 2000, the desktop and Start menu look
slightly different.
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When you have finished configuring Windows, proceed
to “Set up your virtual machine; p. 53.

Migrate data from an earlier version of
Virtual PC

If you have an earlier version of Virtual PC installed, you may
have data that you want to use in Virtual PC 7. There are two
ways to migrate data from an earlier version of Virtual PC to
Virtual PC 7. Use the following table to help you decide which
command to use.
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(f the data is Use one of | To h
stored ona these
virtual machine | commands
that runs
A supported Import PC Import the entire virtual
operating froma machine to Virtual PC 7. This
system, and Previous includes the Windows operat-
was created by | Version ing system, Windows-based
using Virtual PC | — or — programs, and documents
for Mac version | Import from | that were created by using
5.0 or later aPrevious | Windows-based programs.
Version
An unsupported | Transfer Copy only the documents
or unrecognized | Documents | that were created by using
operating from an Windows-based programs.
system Existing PC | The command does not
—or— migrate the entire virtual
Transfer machine.
Documents To use the Transfer
from commands, you must first
Another PC - L
create a virtual machine in
Virtual PC 7 that runs a sup-
ported operating system. You
can then copy the documents
from the existing (source)
virtual machine to the new
(destination) virtual machine.
You can also use the Transfer
commands if you do not want
to import a virtual machine.
The data can then be avail-
able in both the earlier version
\_ of Virtual PC and Virtual PC 7. )
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Important The operating systems supported for
» use with Virtual PC 7 are Windows XP Professional,
Windows XP Home Edition, and Windows 2000.
Refer to the Read Me content for specific details
about the supported operating systems. The
Read Me content is included on the Virtual PC 7
Installation CD, and in Virtual PC 7 on the
Help menu.

Before migrating data

Shutting down Before you import a virtual machine or transfer
data from a source virtual machine to Virtual PC 7, verify that the
source virtual machine has been shut down completely in the
version of Virtual PC in which the virtual machine was created.
For example, if you are importing a virtual machine created by
using Virtual PC for Mac version 6.1, you need to quit

Virtual PC 7, start Virtual PC 6.1, and then shut down the virtual
machine in Virtual PC 6.1. You cannot run an earlier version of
Virtual PC while you are running Virtual PC 7.

Checking virtual machine status Data from a virtual machine
with a “saved state” status cannot be migrated to Virtual PC 7.
The status of each virtual machine is shown in Virtual PC List.

If the status of the virtual machine you want to import or from
which you want to transfer documents indicates that the virtual
machine is “Not Running,” it has been completely shut down.

If the status is “Running,” “Running (Paused),” or “Saved,” you
must use the Shut Down command (Shut down option) to
completely shut down your virtual machine. To completely shut
down a virtual machine, in Virtual PC List, click the virtual
machine, click Shut Down, and then click the Shut down option.
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Virtual Machine Additions If Virtual Machine Additions are not
installed on the source virtual machine, you cannot use the Shut
down option. Instead, you must shut down your virtual machine
from within the Windows operating system. To do this, on the
Start menu in Windows, click Shut Down or Turn Off. In

Windows XP Professional, the Start menu displays the Shut
Down option if you are connected to a domain and Turn Off if you
are not connected to a domain. The virtual machine shuts down
without saving the state of the Windows operating system. Any
data that is not saved prior to shutting down is lost. For more
information about shutting down a virtual machine, see “Shut
down a virtual machine,” p. 54.

Important To prevent data loss, it is a good
practice to duplicate your virtual machine before
importing it to Virtual PC 7. For more information

about duplicating a virtual machine, see
Virtual PC 7 Help.

Import a virtual machine

Use one of the Import commands to import a virtual machine
that runs a supported Windows operating system. These
commands support virtual machines that were created by using
Virtual PC for Mac version 5.0 or later.
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The following table includes important version-specific

information.

('f the virtual machine
that you want to import
was created by using

Notes

Virtual PC for Mac
version 6.x

The original virtual machine settings
are also imported.

If the Undo Drives setting is selected
for the virtual machine that you want
to import, you can choose to either
discard or commit the changes in
the Undo file before importing, or
you can carry forward the associ-
ated Undo file.

Virtual PC for Mac
version 5.x

The original virtual machine settings
are not imported. Instead, when the
virtual machine is imported, the
original settings are cleared and
Virtual PC 7 automatically uses
default settings as for a new virtual
machine.

The Undo file for the Undo Drives
setting is not imported for virtual
machines created by using

Virtual PC 5.x. Before importing, you
must start the virtual machine that
you want to import and discard or
commit the changes stored in the
Undo file. )
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Caution If you import your virtual machine to
Virtual PC 7, you cannot access it in an earlier

version of Virtual PC.

To import a virtual machine
1 InVirtual PC 7, on the File menu, point to Migrate Data,
and then click Import PC from Previous Version.

Tip Alternatively, on the File menu, click New,

@ click Import from a previous version, and then
click Begin.

2 Onthelmporta PC screen, select the virtual machine that

you want to import.

By default, the configuration documents for virtual
machines are saved in the Virtual PC List folder.

3 Click Import.

Caution If you import a virtual machine that runs an
unsupported operating system, a message appears

that describes the potential consequences. If you are
sure that you want to continue, click Continue.

Otherwise, click Cancel, and then transfer Windows-based
documents by using one of the Transfer commands. For
more information, see “Transfer documents from a virtual
machine,” p. 49.

4 Toimport a virtual machinge, click Convert.

When the import process is complete, the operating system
appears in the virtual machine window.
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After you import a virtual machine

If you imported a virtual machine that uses Windows XP or
Windows 2000, Windows will check for new hardware the first
time you start the virtual machine in Virtual PC 7. Because
Virtual PC 7 emulates different hardware than previous versions
of Virtual PC, the hardware settings for your virtual machine must
be updated in the Windows operating system.

This process can take 10 to 30 minutes, depending on how your
system is configured. During this time, your keyboard and mouse
device may not function properly. Do not restart the virtual
machine unless you are prompted to do so.

If you imported a virtual machine that uses Windows XP, you may
need to complete the steps in the following table.

(if your virtual machine uses You may need to A

Windows XP Reactivate Windows XP

Windows XP and was created | Reenter your product key for
\ by using Virtual PC version 6.1 [ Windows XP )

Virtual Machine Additions Before you can use a virtual
machine that runs Windows in Virtual PC 7, you must update
Virtual Machine Additions. If you are not automatically prompted
to update Virtual Machine Additions, you can update them
manually by doing the following: With the virtual machine
running, on the PC menu, click Install or Update Additions. When
you finish updating Virtual Machine Additions, you must restart
your virtual machine.
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Transfer documents from a virtual machine

You can transfer only those documents that were created in
Windows-based programs.

Use one of the Transfer commands if either of the following
applies:

= You want to copy documents from a virtual machine that
runs an unsupported or unrecognized operating system.

® You want your data to be available in both an earlier version
of Virtual PC and in Virtual PC 7.

Before using the Transfer commands, you must first do the
following:

1 Make sure the source virtual machine has been shut down
by using the Shut Down command (Shut down option). In
Virtual PC List, the status of that virtual machine must be
“Not Running.”

If you do not have Virtual Machine Additions installed, you
can shut down a virtual machine by using the Start menu in
Windows. On the Start menu, click Shut Down or Turn Off.
In Microsoft Windows XP Professional, the Start menu
displays the Shut Down option if you are connected to a
domain and Turn Off if you are not connected to a domain.
This option does not automatically save the current state of
the Windows operating system. All data that is not saved
prior to shutting down is lost.

2 Quitall versions of Virtual PC except Virtual PC 7.

3 Ifyou do not already have one, create a new (destination)
virtual machine in Virtual PC 7 that runs a supported
Windows operating system. For more information, see
“Create a virtual machine,” p. 28.
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4 |Install Virtual Machine Additions on the destination virtual
machine. For more information, see “Install Virtual
Machine Additions,” p. 58.

5 Install the Windows-based programs that were used to
create the documents you want to transfer. For more
information, see “Install Windows-based programs,” p. 70.

To transfer documents from a virtual machine to
Virtual PC 7
1 InVirtual PC 7, start the destination virtual machine.
2 Onthe PC menu, click Transfer Documents from
Another PC.

Tip Alternatively, if the destination virtual machine
is not already running, on the File menu, point to
Migrate Data, and then click Transfer Documents
from Existing PC. You will be prompted to start a
destination virtual machine if you have not already

started one.

3 Click the source virtual machine. If you do not see the
source virtual machine, look in the Virtual PC List folder.

4 Click Transfer.

The source virtual machine is now mounted on the
Macintosh desktop and is automatically shared with
the new destination virtual machine. You can now
transfer documents from the source virtual machine
to the destination virtual machine, as described in the
following steps.
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5 Onthe destination virtual machine, on the Start menu in
Windows, click My Computer.

6 Under Network Drives, double-click the drive associated
with the source virtual machine.

If there are multiple drives listed under Network Drives,
choose the one that has the same name as the mounted
virtual hard disk image on the Macintosh desktop.

7 Inthe folder in which you have saved your document, click
the documents you want to transfer. To select all of the
documents, hold down the sHIFT key and click the first and
last documents. To select or deselect one document at a
time, hold down the conTrRoL+0PTION keys and click the
document.

Tip By default, Windows XP Professional saves

documents in the My Documents folder. To open the
My Documents folder, double-click Documents and
Settings, double-click the folder that is named with
your user name, and then double-click My Documents.
If the documents you want are not in this location,
explore the virtual machine until you find them. You
can also use Search (on the Windows Start menu) to
find your documents.

8 Onthe Edit menu of the folder in which you have saved your
documents, click Copy to Folder.

9 In Copy ltems, select the folder where you want to save your
documents on your destination virtual machine, and then
click Copy.
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10 If you have documents in multiple locations on your
source virtual machine, repeat steps 7-9 for each group
of documents you want to transfer.

11 After you have transferred all of your documents, drag
the source virtual machine disk image from the Macintosh
desktop to the Trash.
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Step 3 Set up your virtual machine

Start and shut down a virtual machine

Now that you have created a virtual machine, the next step is to
familiarize yourself with your new virtual machine and configure
settings and connections as you would for a physical computer.
Before you can configure your virtual machine, you need to know
how to start and shut it down completely.

Start Virtual PC 7

To start or shut down a virtual machine, Microsofts Virtual PC for
Mac Version 7 must be running. Like any application for the
Macintosh, you can start Virtual PC 7 by double-clicking the
application icon in the Applications folder.

Tip The first time you use Virtual PC 7, you must start
it by double-clicking the Virtual PC 7 icon in the
Applications folder. Afterward, you can start
Virtual PC 7 from the Macintosh Dock by using the
Keep in Dock command in Mac OS X, or you can have
Virtual PC 7 start automatically when you log on to
your Macintosh computer by using the Login
application preference in Virtual PC 7. For more
information about the Keep in Dock command, see
Mac OS X Help. For more information about the Login
application preference in Virtual PC 7, see
“Application preferences; p. 59.
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Start a virtual machine

When Virtual PC 7 is running, you can use either the PC menu or
Virtual PC List to start a virtual machine. If you have created
multiple virtual machines, you must use Virtual PC List to select
which virtual machine to start; you can also use Virtual PC List to
start a single virtual machine.

To start a virtual machine by using the PC menu
@ |n Virtual PC 7, on the PC menu, click Startup.

To start a virtual machine by using Virtual PC List
1 InVirtual PC 7, on the Window menu, click Virtual PC List.
2 Do one of the following:
= Double-click the virtual machine that you want to start.

= C(lick the virtual machine that you want to start, and
then click Start Up.

Tip You can also start a virtual machine by using the
@ Macintosh Dock. For more information, see “Virtual

machine settings; p.61.

Shut down a virtual machine

The Shut Down command in Virtual PC 7 provides three options
for shutting down a virtual machine.

To shut down a virtual machine by using the
Shut Down command
1 Do one of the following in Virtual PC 7:
= |[fyou have only one virtual machine, on the PC menu,
click Shut Down.
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= |f you have multiple virtual machines, on the Window
menu, click Virtual PC List. Click the virtual machine
that you want to shut down, and then click Shut Down.

2 Do one of the following:

= To save the current state of the virtual machine, click
Save PC’s state.

The Save PC’s state option saves the current state of
the operating system so that the next time you start the
virtual machine, it will appear the same as when you
shut it down. Any program or file that is open when you
shut down using this option will be open when you
restart the virtual machine.

Tip You can also use the Fast Save method to shut

down and save the state of your virtual machine. To
use the Fast Save method, click the red Close button
on the virtual machine window; or in Virtual PC 7, on
the Virtual PC menu, click Quit Virtual PC. When you
use the Fast Save method to shut down, Virtual PC 7
quits and all open virtual machines and the state of
their Windows-based programs are saved in their
current state.

@ To shut down the virtual machine, click Shut down.

The Shut down option safely shuts down a virtual
machine that is running Windowse. This option does not
automatically save the current state of the Windows
operating system. All data that is not saved prior to
shutting down will be lost.

Start and shut down a virtual mochineXSS



Step 3 Set up your virtual machine

Use this option when making changes to your virtual
machine such as turning the Undo Drives setting on or
off, or when mounting a virtual hard disk image. You
must also use this option before importing a virtual
machine, transferring documents from a virtual
machine to Virtual PC 7, or making a duplicate of a
virtual machine. A Windows operating system and
Virtual Machine Additions must be installed on the
virtual machine in order for this option to be available.

Tip If you do not have Virtual Machine Additions

installed, you can shut down a virtual machine by
using the Start menu in Windows. On the Start menu,
click Shut Down or Turn Off. In Microsoft Windows XP
Professional, the Start menu displays the Shut Down
option if you are connected to a domain and Turn Off
if you are not connected to a domain. This method
does not automatically save the current state of the
Windows operating system. All data that is not saved
prior to shutting down will be lost.

e To turn off the virtual machine, click Turn off PC.

The Turn off PC option is equivalent to unplugging a
physical computer and should not be used unless the
virtual machine is not responding and the Shut down
option does not work. If your virtual machine is not
running Windows, use this option instead of the Shut
down option to shut down your virtual machine.

3 Ifthe Undo Drives setting is set for the virtual machine
that you are shutting down, click one of the following
three options:
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= To discard the changes to your virtual machine, click
Discard hard disk changes.

This discards all changes that you made prior to
shutting down. This includes documents that you
created or programs that you installed. Because
these changes were saved in a separate Undo file,
the virtual hard disk image is not altered. When you
restart the virtual machine, a new Undo file is created.

= Toimplement the changes to your virtual machine, click
Save hard disk changes.

This saves changes that you made to your virtual
machine directly in the virtual hard disk image. The next
time you start your virtual machine, the changes are
implemented and a new Undo file is created.

= To save the changes in the Undo file, click Carry forward
undoable changes.

This saves the changes that you made in the Undo
file, rather than in the virtual hard disk image. The
virtual hard disk image is not altered. When you
restart your virtual machine, new changes are added
to this Undo file.

For more information about the Undo Drives setting, see
Virtual PC 7 Help.

Tip If multiple virtual machine windows are open,

click the window of the virtual machine you want to
shut down. The other virtual machines will be paused
in the background and display a status of “Running
(Paused)” in Virtual PC List. You can then shut down
by using the PC menu, or select the virtual machine
with the “Running” status in Virtual PC List and click
Shut Down.
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Install Virtual Machine Additions

Virtual Machine Additions provide system integration features for
use with the Windows operating system. When you create a
virtual machine and install a version of Windows that was
purchased separately from Virtual PC 7, you need to install Virtual
Machine Additions before using your virtual machine.

If your version of Virtual PC 7 includes a Windows operating
system, Virtual Machine Additions are preinstalled and you do
not need to install them. Proceed to “Configure application
preferences and virtual machine settings,” on the next page.

If you import a virtual machine from a previous version of
Virtual PC for Mac, you will need to update Virtual Machine
Additions for that virtual machine.

Virtual Machine Additions provide the following:

Mouse integration Allows the mouse to move freely between
Macintosh and Windows operating systems.

Shared folders Allows you to share information between
your Macintosh and your virtual machine, or among multiple
virtual machines.

Performance enhancements Adds optimized video drivers to
increase the performance of Windows.

Drag-and-drop operations Allows you to copy files between the
Macintosh and Windows operating systems.

Time synchronization Synchronizes the clock in the
Windows operating system with the clock in the Macintosh
operating system.
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Dock application support Allows you to start a virtual machine
by using the Macintosh Dock. For more information about
starting a virtual machine by using the Dock, see “Virtual
machine settings,” p. 61.

Easy printing Allows you to use the same printer as your
Macintosh if you are running Mac OS X version 10.3.x (Panther).
No special configuration is required.

To install Virtual Machine Additions
1 Start the virtual machine on which you want to install
Virtual Machine Additions.

2 Hold down the commaND (88) key and point to the PC menu;
then release the coMMAND (38) key.

3 Onthe PC menu, click Install or Update Additions.

4 Follow the instructions in the Virtual Machine Additions
wizard.

5 When you are finished, restart the virtual machine.

Configure application preferences and virtual
machine settings
After you create your virtual machine, you need to configure it. In

Virtual PC 7, you can set both application preferences and virtual
machine settings.

Application preferences

Application preferences apply to all of the virtual machines that
you created in Virtual PC 7. They are set for the Virtual PC 7
application rather than the individual virtual machine. Application
preferences control behavior such as sound, CPU usage, visual
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display, and other behavior that applies to all virtual machines in

Virtual PC 7.

The following table provides a description of each application
preference.

(Select To A

Alert Behavior | Determine if alert messages will be displayed. In
Virtual PC 7, many alert messages contain a
Don’t show again option. If you select this
option, the alert will not display again in

Virtual PC 7. However, if you want alerts in
Virtual PC 7 to be displayed, you can click
Reset in the Alert Behavior preference and the
alerts will display.

PC Behavior | Suspend activity in background virtual machines
while the active virtual machine is used.

Restart, the next time you start Virtual PC 7, all
virtual machines that were running when you
last closed Virtual PC 7. Click Restore PCs at
launch to set all virtual machines to restart.

Full Screen Determine the behavior of the video settings on
Mode your Macintosh when running a virtual machine
in full-screen mode.

Virtual PC 7 menus and toolbars are not
accessible when the virtual machine is running

in full-screen mode, unless you press the
COMMAND (38) key. To return to the normal screen
mode, press the coMMAND (38) and RETURN keys
\_ simultaneously. )
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elect To A

(s

Virtual Switch | Determine which Ethernet adapter to use with a
virtual machine that is set to run with the Virtual
Switch network option.

Sound Set the behavior of system sounds on all virtual
machines.

CPU Usage Determine how to divide processing resources
between Virtual PC 7 and other applications
that are running simultaneously when

Virtual PC 7 is not the active application on the

Macintosh.
Scripting Add the AppleScript menu to the Apple
menu bar.
Toolbar Select the items that will appear on the
Virtual PC 7 toolbar.
Login Set Virtual PC 7 to start automatically when you
\_ log on to your Macintosh computer. Y,

To configure application preferences
1 InVirtual PC 7, on the Virtual PC menu, click Preferences.

2 Click the application preference that you want to configure.

For more information about application preferences, see
Virtual PC 7 Help.

Virtual machine settings

Virtual machine settings are unique to each virtual machine that
you create in Virtual PC 7. These settings are set for each virtual
machine rather than the Virtual PC 7 application. Virtual machine
settings control behavior such as printing, connecting to a
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network, using USB devices, and other behavior that applies
to individual virtual machines running in Virtual PC 7.

The following table provides a description of each virtual
machine setting.

@elect To A

PC Name Give a name to the virtual machine, which will
appear in Virtual PC List.

PC Memory | Select how much RAM and VRAM will be allocated
when this virtual machine is running.

Drive 1,2, | Assign additional virtual hard disk images to a

and 3 virtual machine. Drive 1 is the default primary drive.
Undo Save all changes made to a virtual machine in
Drives a separate Undo file so that the virtual hard disk

image of the virtual machine remains in its
original state.

Shared Create a shared folder to easily transfer files
Folders between your Macintosh and a virtual machine.
Mouse Customize the key combination on your keyboard

to enable a single-button mouse to “right-click”

Keyboard | Assign special computer keys, such as the
Windows key, to your Macintosh keyboard.

Com Ports | Assign a physical serial device or file to a virtual
1and2 machine’s emulated serial ports.

Networking | Select either the Shared Networking or Virtual
Switch networking option.

UsB Allow a physical USB device to be used with a
\_ virtual machine. Y,
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@elect To

Dock Display Windows-based programs that are
currently running in the Dock. If you have multiple
virtual machines, the programs running on each
virtual machine will appear in the Dock. To deter-
mine which virtual machine is running the program,
use your mouse device to point to the program
you want. The name of the virtual machine will
appear above the program icon.

Display the Windows Start menu in the Macintosh
Dock. This version of the Windows Start menu is
not a fully functional menu, but rather, a quick way
of starting a virtual machine and Windows-based
programs by using the Dock. Clicking on this icon
in the Dock will first open Virtual PC 7 and then the
virtual machine for which this setting is selected.

If you have multiple virtual machines, only the
programs that are installed on the virtual machine
for which this setting is selected will appear in the
Start menu. This setting can only be selected by
one virtual machine at a time.

You must install Virtual Machine Additions in order
to have Dock integration with Virtual PC 7.

Printing Select the Virtual Machine Additions Printer. This is
available only if you are running Mac OS X version
\_ 10.3.x on your Macintosh. )
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To configure virtual machine settings
1 Do one of the following in Virtual PC 7:
= |f you have one virtual machine, on the PC menu, click
PC Settings.
= [f you have multiple virtual machines, on the Window
menu, click Virtual PC List. Click the virtual machine you
want to configure, and then click Settings.
2 Click the virtual machine setting that you want to configure.

For more information about virtual machine settings, see
Virtual PC 7 Help.

The following sections describe how to set up the printer and
network connections for your virtual machine.

Printing

In Microsoft Virtual PC 7, there are several ways to establish a
printer connection for your virtual machine. The method you
choose depends on the operating system that is installed on your
Macintosh and whether the printer you want to use is a printer
directly connected to your Macintosh or a printer on a network.
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Use the following table to determine the printer connection that is

best for you.
(Iam running My printer is Recommended printer h
Mac OS X connection for your virtual
machine
Version 10.3.x Connected Use the Virtual Machine
directly to my Additions Printer.
Macintosh
On a network Use the Virtual Machine
Additions Printer.
Version 10.2.8 Connected Connect to the USB printer
directly to my independently of the
Macintosh Macintosh.
On a network For more information
about connecting to a
network, see your network
\_ administrator. )

Important In Virtual PC 7, the virtual machine
» does not automatically capture USB printers for
use. To use a USB printer with a virtual machine,
you must first capture the USB printer for use by
the virtual machine. For more information about

using USB devices with a virtual machine, see
Virtual PC 7 Help.
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If you are running Mac OS X version 10.3.x on

your Macintosh

If your Macintosh is already set up to print from either a printer
connected directly to it or a printer on a network, use the Virtual
Machine Additions Printer driver as the printer connection for
your virtual machine. The Virtual Machine Additions Printer driver
uses the printer connections that have already been established
for your Macintosh and requires no additional configuration. The
Virtual Machine Additions Printer driver can be used only with a
virtual machine that is running a supported operating system.

The driver for the Virtual Machine Additions Printer is auto-
matically installed with Virtual Machine Additions. To use the
Virtual Machine Additions Printer driver, Virtual Machine
Additions must be either:

= [nstalled for a new virtual machine that contains a version

of Windows XP purchased separately from Virtual PC.

@ Updated for a virtual machine that has been imported.
Virtual Machine Additions and the Virtual Machine Additions
Printer driver are automatically installed on your virtual machine
if you install the version of Windows that is included with
Virtual PC 7.
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Tips Before you can use the Virtual Machine
@ Additions Printer driver, you must first set up a printer

for your Macintosh and verify that it is working properly.

If other printers are installed in the Windows operating
system of the virtual machine, you must select the
Virtual Machine Additions Printer as your default printer.

The Virtual Machine Additions Printer is the
recommended and easiest printer connection,

but you can also connect your virtual machine to a
USB printer independently of the Macintosh or use
emulated printing.

If you are running Mac OS X version 10.2.8 on

your Macintosh

If the printer you want to use is a USB printer that is directly
connected to your Macintosh, you can establish a separate USB
printer connection for your virtual machine that is independent
of the USB printer connection for your Macintosh. This means
that the USB printer and the necessary printer drivers must be
installed in the Windows operating system on your virtual
machine in addition to being installed on your Macintosh.

If the printer you want to use is on a network, see your network
administrator for more information about connecting to
a network.
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Itis also possible to use emulated printing as the printer
connection for your virtual machine. However, the emulated
printing connection is not recommended and should be used only
if no other printing option is available.

For more information about setting up a printer for your virtual
machine, see Virtual PC 7 Help.

Networking

In Virtual PC 7, the Networking setting provides the following
two options for establishing a connection to the Internet:

Shared Networking By using the Shared Networking option,
you can connect a virtual machine to the Internet by using the
Internet connection of the Macintosh computer. This option
works well for standard networking tasks such as browsing
the Web; reading e-mail; or accessing shared resources such
as printers, files, or File Transfer Protocol (FTP) sites. The
Shared Networking option is automatically set as the default
network option.

Important Use Shared Networking when Airport or
other 802.x wireless connections are active.

Virtual Switch The Virtual Switch option is designed for
advanced networking tasks such as joining a network domain,
or running a Hypertext Transfer Protocol (HTTP) or FTP server
with predefined port numbers or a remote login (rlogin). If you
use this option, the virtual machine becomes a fully functional
network node that can communicate with other virtual machines
running on the same Macintosh computer or other computers on
the network.
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Important To use the Virtual Switch option,
» you must have a router or method of obtaining

individual unique Internet Protocol (IP) addresses.
Virtual Switch may require changing networking
settings within the operating system of the virtual

machine and may be dependent on how a
particular network is configured.

For more information about selecting the networking option, see
Virtual PC 7 Help.
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Step 4 Install Windows-based
programs

Install Windows-based programs

You can install programs that run on the Microsofte Windowse
operating system by using an automated installer or by using the
Start menu in Windows.

To install a Windows-based program by using an
automated installer
1 Startthe virtual machine on which you want to install
the program.

2 Insertthe installation CD for the program into the CD drive
of your Macintosh.

The active CD icon on the toolbar in Microsoft Virtual PC
for Mac Version 7 indicates that the virtual machine has
captured the CD. If the virtual machine does not capture
the CD, in Virtual PC 7, on the Drives menu, click
Capture Disc.
To install a program from a floppy disk if your Macintosh
does not have a floppy disk drive, use a floppy disk image.
For more information about using floppy disk images, see
Virtual PC 7 Help.

3 Double-click the installer icon and follow the directions on
the screen.
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To install a Windows-based program by using the Start
menu in Windows

1

Start the virtual machine on which you want to install
the program.

Insert the installation CD for the program into the CD drive
of your Macintosh.

The active CD icon on the Virtual PC 7 toolbar indicates that
the virtual machine has captured the CD. If the virtual
machine does not capture the CD, in Virtual PC 7, on the
Drives menu, click Capture Disc.

To install a program from a floppy disk if your Macintosh
does not have a floppy disk drive, use a floppy disk image.
For more information about using floppy disk images, see
Virtual PC 7 Help.

In Windows, on the taskbar, click the Start button in the
lower-left corner.

On the Start menu, click Control Panel.

If Control Panel is not visible, click Settings, and then click
Control Panel.

Double-click Add or Remove Programs, and then click Add
New Programs.

Click CD or Floppy.

Follow the instructions in the Install Program From Floppy
Disk or CD-ROM wizard.

To eject the CD, in Virtual PC 7, on the Drives menu, click
Eject Disc.
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Start Windows-based programs

In Windows, the Start menu provides an easy way to access
programs and documents.

To start a Windows-based program by using the Start
menu in Windows
1 Startyour virtual machine.
2 Onthetaskbarin Windows, click Start, point to All
Programs or Programs, and then click the program
you want.

Tip You can also start a Windows-based program
@ by using the Macintosh Dock. For more information,
see “Virtual machine settings; p. 61.

For more information about using Windows-based programs, see
Virtual PC 7 Help, or on the Start menu in Windows, click Help
and Support or Help.
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More help and support

Online Help

The following table describes where to find the Help that is
available for Microsofte Virtual PC for Mac Version 7, and
Microsoft Windowse XP Professional, Windows XP Home Edition,

and Windows 2000.

(I'o access online

Help for

Do this )

Home Edition

Virtual PC 7 In Virtual PC 7, on the Help menu, click
Virtual PC Help.

Macintosh OS X In Macintosh OS X, with the Finder in the
foreground, on the Help menu, click Help.

Windows XP In Windows XP on the Start menu, click

Professional and | Help and Support.

Windows XP

Use Search to search the Windows XP Help
topics and the Microsoft Knowledge Base
for solutions.

Windows 2000

In Windows 2000, on the Start menu,
click Help.

Windows-based

programs click the appropriate help option.
Read the documentation included with your
\_ Windows operating system. )

On the Help menu of an open program,
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Product support

Technical support for Virtual PC 7 and the Windows operating
system is available on the Microsoft Web site.

Virtual PC 7 Visit the Macintosh support area of the Microsoft
Web site at http://www.microsoft.com/mac/.

Windows XP and Windows 2000 Visit the product support area
of the Microsoft Web site at http://www.microsoft.com/support/.

For the most recent listing of telephone numbers for Microsoft
Product Support Services, visit the product support area of the
Microsoft Web site at http://www.microsoft.com/support/.

Microsoft Product Support Services are subject to changes in
price, terms, and conditions without notice. Support options,
hours, and cost in your country may differ from the United States.
Check with your local subsidiary for details.

Product identification number (PID)
If you call Microsoft Product Support Services you may be asked
for your product identification number (PID) for Virtual PC 7.

To find your product identification number (PID)
1 InVirtual PC 7, on the Virtual PC menu, click About
Virtual PC.

2 Click the Info tab.
3 The Product ID is under Registration Information.
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Check for updates

You can get product updates for Virtual PC 7 and the Windows
operating system on the Web.

For updates of Virtual PC 7, do one of the following:

@ |n Virtual PC 7, on the Help menu, click Check for Updates.

= Visit the Macintosh support area of the Microsoft Web site
at http://www.microsoft.com/mac/.

For updates of Windows XP and Windows 2000, visit the update
area of the Microsoft Web site at http://www.microsoft.com/.

Register Virtual PC 7

To register your copy of Virtual PC 7, in Virtual PC 7, on the
Virtual PC menu, click Online Registration.
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